Sage Estimating

(formerly Sage Timberline Office
Estimating)

Getting Started with Digitizer
Standard Version



NOTICE

This document and the Sage Timberline Office software may be used only in accordance with the
accompanying Sage Timberline End User License Agreement. You may not use, copy, modify, or transfer
the Sage Timberline Office software or this documentation except as expressly provided in the license
agreement.

Visit our website to learn about training classes that are added throughout the year.

©2005 Sage Software. All rights reserved. The Sage Software logo and the Sage Software product and
service names mentioned herein are registered trademarks or trademarks of Sage Software, Inc., orits
affiliated entities. All other trademarks or registered trademarks are the property of their respective holders.

32100.3



Welcome to Timberline Digitizer .................................

How touse thisbooklet .......... ... ... ... ... . .. .. .. ...,
Help - always at your fingertips . .. .......... ... ...
Comprehensive help on your computer ...................
Technical support .. ... ... .
First things first . ........ ..
Check your product package .................. ... .. ....
Install the software .. ....... ... .. ... . . .. . . ...
How to start Timberline Digitizer

Some basic concepts

How to work with a digitizing device ..........................
The Digitizer window . .......... ... ... ..o,
What you see in the graphicsarea .......................
How to deal with a large drawing . ......................
How Digitizer works with Estimating ....................... ...
Using Digitizer . . ...t

Contents



The ABCs of digitizing ............... . ... .. ... . ... ... ... 11

Using the Help system .......... ... ... . . ... 12
Locating the tabletmenu . .. .......... ... ... ... ... . ... .... 14
Selecting part of the plantoworkon ........................ 16
Setting the drawing scale ............ ... .. ... ... .. .. .. ... 18
COUNLING . ..ot e e e 20
Digitizing single lines .. ....... ... .. ... . .. . . 22
Digitizing continuous lines .. ............ .. ... ... ... ..... 24
Digitizing areas . . .. ...oou it e 26
Printing theimage ............ ... ... . . i 28
Time-savingtips .......... ... ... .. . 31
Making the most of Digitizer .......... ... ... ... ......... 32
Shortcut menus . ........ ... ...t 32

Status bar . .. ... 32
Totalsbar ....... .. ... . 32
Placing the toolbar conveniently .. .................... 33

Saving animage . ...t 33

What to do if you make amistake .................... 34
Digitizing from Estimating ................ ... ... ... ....... 35
Setting the digitizing mode in advance . ................ 35
Goahead ... tryitout ....... ... ... 37
Andinconclusion .......... .. ... . i 37

Getting Started



Welcome to Timberline Digitizer

Timberline® Digitizer Standard from Timberline Software is intended to bring a full
range of digitizer functionality to users of Estimating. As soon as you are familiar with
the information in this booklet, you should be ready to begin using Digitizer.

How to use this booklet

We know you are eager to start working as quickly as possible, and the goal of this
booklet is to help you do just that. Depending on your level of experience, you may find
the following sections of interest.

= Some basic concepts — the concepts and philosophy behind Digitizer

= The ABCs of digitizing — step-by-step instructions for the most commonly performed
procedures

The discussion about using our extensive Help system should be of particular interest
to all users.

= Time-saving tips — helpful hints for using Digitizer

= Go ahead ... try it out — a last word of advice

Welcome to Timberline Digitizer 1



Help - always at your fingertips

Digitizer provides all Comprehensive help on your computer

the help you need right

on your computer. In Instead of bulky manuals that you never quite get around to
addition, our competent reading, help files come with Digitizer. Our efficient Help
technical staff is ready system provides faster access to more information than most
to assist you. manuals. With a click of the mouse or a keystroke, you can

. easily get help for a command, a field, a window, or a procedure.
= The software includes

acomprehensive Help 7 w2

system. It provides not

only context-sensitive » Help | 4—{ Window level help ‘
help about what you !

are doing, but also

step- by-step instruc- il .
tiOl’lS and “Show Me” HEIF:' Tl:lf:lil::E: |<7 TOpIC level help
demos. What's This? <+ Context-sensitive help
» If you purchased the Show Me Demos 4—— Video demonstrations
software, you auto- dsing Help < Instructions for using Help
matically receive 90 License Agresments  <€— Timberline licences
days of free telephone -mai
suy oﬁfand ot}fer Timberine Services.., — Telephone and e-mail support
b ppf't Timbetline on the Wwieh * [¢——— Web site for Timberline Software
enejiits.

About POWIN... <——— Software version information

= You can also obtain
information from our
web page (www.tim-
berline.com) on the
Internet.
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Technical support

If you have questions or problems not covered by the Help system, you can communicate

by telephone, FAX, or e-mail. The US support line is open from 7:00 a.m. to 5:00 p.m.

Pacific time, Monday through Friday. Outside the US, contact your nearest distributor.

For support in Call FAX E-mail
US/Canada 1-800-551-8307 | 503-439-5940 | pesupport@timberline.com
Australia 1800 120 369 1503 439 5940 | austrest@timberline.com

+503 439 5178
Asia-Pacific +503 439 5178 | +503 439 5940 | austrest@timberline.com
Other international areas +503 533 2181 | +503 439 5940 | pesupport@timberline.com

When calling, have your customer number handy and be at your computer.

= [f you are not on a service plan, you can call on a charge-per-call basis. Please be
prepared to give the number of a major credit card when you call.

= [If you are using the trial software, please contact your local Solution Provider
(authorized Timberline dealer).

Welcome to Timberline Digitizer
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First things first

The first thing you need to do is to set up the Timberline Estimating products on your
computer. Timberline has automated the installation procedure, so the entire process
takes only a few minutes.

Check your product package

The product package includes everything you need to install and use Digitizer. In
addition to this booklet, you will find the following:

= The Timberline Estimating CD-ROM, which includes the Digitizer software. Your
Digitizer access code installs Digitizer and the help files that give step-by-step
instructions for using the software.

= A packing slip (with activation codes for each Timberline application).

= An installation card for basic instructions on installing the Estimating products.

Install the software

For information about installing the Estimating products, refer to the installation card
included in the product package. You can find more detailed installation instructions,
as well as tips for setting up Timberline Estimating, in the Resource and Installation

Guide located on the CD-ROM in the Documents folder.

How to start Timberline Digitizer

After installing the software, you can open any Timberline application from the Start
menu.

1 If you did not restart your computer at the end of the installation, do so now.
2 From the Start menu, open the Program group and then the Timberline Office group.
3 From the Estimating group, choose Digitizer.

Note: The typical method of starting Digitizer is directly from Timberline
Estimating.

Getting Started



Some basic concepts

If you are new to Digitizer, there are a few basic concepts you should understand before
you begin using the product. The concepts are not difficult, and you may already be
familiar with some of them. After reading this section, you will be ready to try the
procedures in The ABCs of digitizing.
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How to work with a digitizing device

Digitizing involves The Digitizer window

using a pointing device

(stylus or puck) to The graphics area, which corresponds to the digitizer tablet,
transfer the dimen- occupies most of the main window. The menus, toolbar, and
sions, lines, and shapes status information are located above and below the graphics
on the digitizer tablet to area.

your computer. The

lines and points you Title bar

dtgmzfe appear in the %i’l‘ga?ar

graphics area of the

Digitizer window.

File Edit “iew Digitize | Tools Help

RN M G R E I NI T

Among the things you
can control in the digi-
tizer window are:

= toolbar position and
shape

Graphics area
= background color

= kind of units
® number of decimals
shown

X [ Total 1.00
® line color and style [For Help, press F1 [308.26 [141.74 5c$ 14 [Court 171 [1 2

= count symbol

Totals bar

n i l
display of coordinates Status bar

:@% After you attach a digi-
tizer and install the
driver, you can use the
pointing device as your
mouse.
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What you see in the graphics area

Whenever you start Digitizer, the screen is set up to encompass as much of the digitizer
tablet as possible. There is a direct correspondence between the top and bottom of the
digitizer tablet and the top and bottom of the active area on the screen. You can easily
resize and reposition the screen to include a work area anywhere on the digitizer tablet.

Ffl powin [_ 0] %]
File Edit “iew Digitize Toolz Help
R A E R A L
~
~
~
~
~
~
~
~
~
. ~
Active Area ~
~
~
~
~
~
~
* ~ [ ~ Total
|Fer Help, prass T ~ |206.26 [141.7% [Scale 1/4 [Coun
~ — ~ Digitizer tablet
~ ~
~ ~
~ - ~
~ - ~ -
~ ~
~— - ~
~ ~
~ ~

How to deal with a large drawing

If you are working with large plans, it is more efficient to focus on one part of the drawing
ata time. You simply define a work area on the drawing tablet by using the Zoom Window
command in Digitizer. Defining a work area accomplishes two things:

= [t enlarges the digitized image on your screen.
= [t keeps the Digitizer menus within easy reach.

See page 16 for more about how to focus on a portion of the digitizer tablet.

Some basic concepts T



How Digitizer works with Estimating

Digitizer is available
Jrom takeoff quantity
and variable fields in
Estimating. You can
access the digitizer
directly from the Esti-
mating spreadsheet or
Jrom windows used to
enter variables.

As a productivity tool,
Digitizer lets you:

Mo

“{” Once you choose a digi-

make measurements
on blueprints and
transfer the measure-
ments directly into
Estimating.

set the drawing scale
used for calculating
dimensions.

tizing mode, you may
notice that the mouse
and pointing device
move the cursor at dif-
ferent speeds.

8
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In Estimating, the estimate is represented by a spreadsheet that
contains items brought in from the database. Digitizer can be
used to measure and calculate the takeoff quantities for the items
in the estimate.

Using Digitizer

As you digitize or trace shapes on the blueprint, Digitizer draws
the image, measures the shape in the scale you’ve set up, and
displays the result on your screen. This is particularly useful for
obtaining the dimensions of formula variables during takeoff.
And if the variable has a preset digitizer mode (see page 35),
Digitizer automatically starts in that mode (Area, Single Line,
Continuous Line, or Count).

Right-click a variable field to
open a shortcut menu with ——_
the Digitizer command.

[ ltem Takeoff: McKenzie Oaks

= F11.00 Farme: Footings ﬂ Cluantity 1.000 | each
2] 10 Footing Farms [Single use] J Length ' feat
B 20 Stakes At Foms cut ClrleX

40 Foating Steps

[l o

— i Lo Clrl+C
B0 K.ewway In Footing ﬂ oRy e ﬂ
Phase | Item| Description | Qu Delete Del tem| «
1 | 3111.00(50 Keyway In Footing
2 Calculator... F11
EI Edit Varishle...

o
T |-
L\L

[

v 0 Clear YWariables

to start the Digitizer. —

Recall Perimeter
Click here P) What's This?




You can send a single total to Estimating right away or accumulate several measurements

and send them as a single dimension.

File Edit “iew Digtize Toolz Help

o N[O | = | 5| Bl oL |

=0 S X |5 W W2

When you finish
digitizing the
dimension, click
here ...

... to bring the
total into the
selected field in

Estimating. Segment 0.00

Length 0.00

Total 167.00

|Digitize the firzt point of the line

[113.22 [137.06 [Scale 1/4 [Caunt 1/

[ tem Takeoff: McKenzie Oaks 2 [ _ O]

A111.00 Farme Foatings

10 Footing Forms (Single use] _I
20 Stakes At Forms
40 Footing Steps

Guantity

1.000 | eac

Length *|

157000 | Feet |

Rk vy Footing || Pas2 +| =
Phase | Item Description Quantity | Unit Location

1 111.00(50 Fepway In Footing 167.000 | Inft
O o
¢ 0K | x LCancel ? Help |

Some basic concepts
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The ABCs of digitizing

Now that you understand the basics of Digitizer, you are ready to start digitizing. This
section includes an overview of the steps required to complete some of the tasks you
perform most often.

= Using the Help system

= Locating the tablet menu

= Selecting part of the plan to work on (Zoom Window command)
= Setting the drawing scale

= Counting

= Digitizing single lines

= Digitizing continuous lines

= Digitizing areas

= Printing the image

The ABCs of digitizing 11



Using the Help system

No matter where you Get help about a field or window

are in Digitizer, there is

help available. How you You can get information about the commands, buttons, fields,
get to the information is options, or windows in Digitizer with a single keystroke or click
entirely up to you. One of the mouse.

way is to go directly to

the appropriate help Horizontal

topicfrom aﬁeld or Erter the harizontal plan scale in this field. If

. . the plan scale is imperial, erter the scale as a : )

window. Another way is fraction. For example, erter 1/4 to represert s For information
. . zcale of 14" to 1'. If the plan scale iz metric, about a field or
to IOOkfor tOplCS usmg enter the scale as a ratio (e.g. 1:10007. option, click here
the Contents, Index, % 2000, Timberline Safware Carpartian, Al righs resaned. then click the field.
and Find tabs in the
Help window.
Keep in mind that the
Help system contains Hone 72 Tecale lets you set the scale using a
. . . kniowr length from the plan.
all of the information in Vetical [74 » _ _

. Digitize two pointz on the drawing and then
thls bOOk and much enter the distance between the points.
more. Step-by-step help Count scale The drawing scale iz calculated for pou
topics and “Show Me”’ _ sutematial:

. 1 ta 1
demos are available to __ tuosde |
gulde you through ¥ Save cument scales as default

many of the procedures

. . . v K
covered in this section.

)

B Precision Digitizer For information
Help Topics Dptions Wersion Ask Me about the window
Scales window click here.

Thiz window allows you to enter the horizontal and vertical drawing scales and
the count scale. The harizontal and vertical scales can be entered using the

To open: On the Digitize menu, choose Scales.

For help on an item in this window, click il on the toolbar and then click the
item.
Tip
w Click in any of the scale fields on the Status bar to open the Scales window

I Related Topics

12  Gertting Started



Learn how to complete tasks with procedural topics

The Help system also includes step-by-step instructions for most tasks and procedures. It
is always a good idea to check the "Related topics" at the bottom of a help topic for jumps
to these procedural topics.

Find information

In the Help system, you can find information by looking in the table of contents and index
and searching for specific word.

Help Topics: Precizion Estimating Help EE3 If you can’t find what you need
Contents | Indes | Find | in the Contents or Index,
you can search for any word
Click a baok, and then click Dpen. Or click another tab, such as Index. or combination of words.
This tab
lists the @ Precision E stimating basics
primary @ wiorking with databases
tOpiCS. @ Producing estimates Help Topics: Precizion Estimating Help EE3
@ Prihting.reports Indes | = I
@ Using File Tools
aking th t
@ a. na ihe mes 1 Twpe the first few letters of the word vou're looking for.
@ Using Help
@ Show Me,demo collection Il
@ dditioyla) Estimating infarm 2 Click the index entry you want, and then click Display.
# in spreadshest . o S—
* in spreadshest Help Topics: Precision Estimating Help
<formula name: command -
about applications Contents I Index  Find
about Timberline
ABS .
Absolute Valus function 1 Type the word(s] you want ta find
accelerator keys Idefaulﬂ j Clear |
ACOS
activation 2 Select zome matching words to narrow pour search Options. |
Add Benefit Column comnmatu Fault =
Add Item command " Find Sirnl
f Additional hours cost basis fo Irid sl |
. L . addons
This tab is like the index to slacating Eind Hovs |
inlki H changing [editing)
a bO_OK' CIICkIng a _Word n cost basis options for LI Febuid... |
the list takes you directly to
that topic or displays a list 3 Click a tapic, then click Display
of relevant topics.

Adjusting the estimate prices by a percentage

ASCI Sort Setting window

Agszigning items to a location or WES

Base Amount column [all categories]

Base Productivity column [Labor, Equip) LI

81 Topics Found | I All words, Begin, &uto, Pause |

Dizplay I Erint.. | Cancel |

The ABCs of digitizing 13



Locating the tablet menu

access to most of the

features on the menus Place the tablet menu within the active area on your digitizer. We

The tablet menu gives @ Position the tablet menu

and toolbar in Digitizer. recommend you tape the edges to securely fasten the tablet
Using the tablet menu is menu to the digitizer.

optional, but it can

eliminate the need to

move back and forth Precizion Digitizer el
between the digitizer .| | [ | e | —

and the keyboard.

The Locate Tablet

Menu function tells

Digitizer where the tab- o
let menu is located on
the digitizer, thus per-

forming the necessary Choose the Locate Tablet Menu command

1z,
| =] 3 v
o3| = G| X

setup for the tablet

meni towork, You can find this command on the Tools menu.

This option is available e
only if: ——
= Your digitizer is

hooked up. Set Digitizer Buttons. .

Define Lines Count Symbal. ..

)
® You’ve checked the Locate Tablet Menu
E’m?le tablet rfwn i To locate the tablet menu,
box in the Options click here.
window.

= Digitizer can find the
PDWmenu.dat file.

14  Gertting Started



Digitize the points on the tablet menu

When you select the Locate Tablet Menu command, your cursor changes to a crossbar
and the first prompt displays in the status bar.

| 2. Digitize this point second.

Frecizion Digitizer e

1. Digitize this point first.

The ABCs of digitizing 15



Selecting part of the plan to work on

Before you begin doing
takeoff with the Digi-
tizer, you might want to
select part of the plan to
Jfocus on. You can use
the Zoom Window com-
mand to identify the
portion of the plan
where you want to work.
“Zooming in” on the
plan makes it easier to:

= Digitize large
drawings.

= See details of the
digitized image in the
graphics area.

16 Getting Started

Choose the Zoom Window command

You can find this command on the View menu and the toolbar.

[3

e

Zoom Window

Zoom Extents
To define a i
work area, click Lepap Lok
here or here. v Tool Bar
v Totalz Bar
v Statuz Bar

Digitize the upper left corner

Digitize the upper left corner of the area where you want to work
and drag your pointing device (mouse, stylus, or digitizer puck)
down and to the right.

A zoom rectangle appears to help you define the boundaries of
the section where you want to work.

R powin H=

File Edit “iew Digitize Toolz Help

g 5 [ [ | B E] 0 M (0% /& X H W

Upper left corner

i Zoom rectangle :

"

[ [ Total 0.00

|Digitize the lower right comer of the zoom rectangle |135.16 [45.47 [Scale 1/4 [Count 141 1 2




Digitize the lower right corner

When you reach the lower right corner of the section you want to work on, click again.

File Edit “iew Digitize Tools Help

Ty N L e = | B[ 5] D | N

VAR L

: Zoom rectangle

.

Lower right corner

[ [ Total | 0.00
|Digitize: the: loweer right comer of the zoom rectangle [135.16 |45.47 |Scale 144 [Count 141 |I_ 5

After you finish digitizing one part of
a large drawing,

click here to select another area,

or click here to reset the graphic area

//' to include the entire digitizer tablet.

"o =ait
ERcalEN-—4
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Setting the drawing scale

There are two ways to
set the drawing scale:

= Known scale — use
this procedure when
the scale is provided
Jor you and you are
confident that it’s
correct.

® Autoscale — use this
procedure if the
drawing is not to
scale or the scale is
not provided for you.

You can see the current
drawing scale in the
right corner of the
Status bar.

18 Gertting Started

Open the Scale window

You can find the Scales command on the Digitize menu, the

toolbar, and the status bar.

B]

To open the

click here,
here,
or here.

"q” mmmm
g’D'H IE S

Scales window,

For Help, press F1

?

Count

Single Line
Caontinuous Line
Area

Enter a known scale

If you know the drawing scale and are confident it is correct,
enter the horizontal and vertical scales in the Scale window.

Horizontal |1./4

Wertical (1.4

Count zcale

—

Lix]

—

[ Save cument scales az default

Scale 1/4 Count 14 |1

Enter the horizontal and

vertical scales in these fields.

Hutoscale lets pou zet the scale uzing a
known length from the plan.

Digitize two points on the drawing and then

enter the distance bebween the points.

The drawing scale iz calculated for you
automatically.

Autoscale

« Ok | ¥ Cancel | ? Hep |




Use automatic scaling

If you aren’t sure of the drawing scale, you can have Digitizer calculate the scale for you.
To set the scale using a given line, you simply click the Autoscale button and digitize that

line.
Scales
larfirte] |1 24 Autozcale lets pou set the scale using a
= known length fram the plan.
Wertical I'I.-"4 _ . 2
Digitize two paints on the drawing and then
enter the distance between the points.
Click here.
el sl The drawing scale iz calculated for pou
= automatically.
I-I to |1 Autozcale

[ Save cument scales as default

Autoscale

Autozcale can calculate independent scales if the
horizontal and vertical scalez on the drawing are
different,

" Close | ?  Help

. . . L I ark the appropriate option to indicate if the
Click the appropriate option to indicate horizontal and vertical scales are the same or

whether the horizontal and vertical scales different.
are the same or different.

* Harizontal and wertical scales are the zame

" Huorizontal and vertical scales are different

o 0K I X Cancel | ? Help

Autoscale

Press the Esc key
to cancel at any time.

Digitize the first and last points ... ‘
Same Scale {

Digitize the first point. 2 ?3,3.?SJ
Digitize the second point. f.64.3.05

Enter the length of the line. | 4——4 ... and enter the length of the line. ‘

Click OK to have Digitizer calculate
v oK X Cancel | the scale automatically.
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Counting

Count mode tells you
how many points have
been entered with the
digitizer. In addition,
you have the ability to:

= Choose the count
symbol that appears
on the screen either
before you start or
while you are count-
ing.

= See the previous and

currentdimensions by
clicking the totals bar.

= Set up a count scale
which is used as a
multiplier for each
point you digitize.

20 Getting Started

Start Count mode

You can find the Count command on the Digitize menu and the
toolbar.

Digitize

T2y N Y [y Count

K To start this mode, j Elngl.e Line _
click here or here. Confinuous Line

Area

To select a count

symbol, click here. 4\ Scales..

Digitize the points

As you digitize, the number of points displays in the totals bar.
The current total can be added to or subtracted from the grand

total. The Undo button allows you to remove count points one at
a time.

Efl powin [=] E3

File Edit “iew Digtize Toolz Help

BRSNS

Add j

Subtract ¢ *

eI T

Grand total
[ Current total \

Count 4.00 Total 0.00

| Diigitize the lacation for the spmbol [145.01 [119.39 [Scale 1/4 [Caunt 141 [I




Send the value to Estimating

You can add several counts and send them as a single total. When you finish counting,
clicking the Done button sends the total to the selected field or cell in Estimating.

Fflrovin [_ O] %]

File Edit “iew Digitize Tools Help

Moy N [ o= (BT R0 W22 |0 S X | & W2
Click here
to send the total from ° °
Digitizer ... ° °

L[] [ ]
Count 0.00 Total | 6.00

’ ... to Estimating. ‘ | Digitize: the lazation far the symbal [138.15 [124.14 [Scale 1/4 [Count 1

McKenzie Oaks 2

Group Phase Description ;:';f::y Labor Price nLr:hu?J:'n =
8000.00 DOORS & WINDOWS
8210.01 |Doors: Wood
Dot Fire Core 2-100x B-3 3.00 each| 2000 our
852001 (Windows: Aluminum
incioy - Aluminum 6.00]
0000.00 FINISHES

09253.30 |GWB: Boards & Sheathing
GWE 172" Al Sizes Regular 5,000.00 =gt 20,00 shour 3,000 —I
GWE 172" All Sizes Regular 1,00000 =gt 20.00 fhour 500 | o

P“Phaseﬂtem,{ Takeoff Order A Azzembly A LocationPhaze A Bid temPhase || 4 | | L4

-
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Digitizing single lines

culates the straight-line

distance between two You can find the Single Line command on the Digitize menu and

Single Line mode cal- @ Start the Single Line mode

digitized points. For the toolbar.
example, you might use
this mode to measure == '\ II'_I|I E

Count

Jjoist or rafter lengths.
At any time you can: To start this mode, ’m
click here or here. Continuous Line

» Define the line style

Area
and color that =
To define the line style
appears on your and color, click here. SN S
screen.
= See the last and cur- El " IE amm
rent dimensions by e ===
clicking the totals bar.

1 As mentioned before, Digitize the beginning and end of the line
the toolbar includes . e L
Bt e e o For each line, digitize the two ends. Digitizer calculates the

length which then appears as the current total in the totals bar.
to add or subtract the Lo . . .

Digitizing a third point starts a new line and adds the current
current total to the

il s Tdts total to the grand total.
button removes the last

line digitized. i povin M=

File Edit “iew Digitize Tools Help

Tz | 5 [ | o= | BT B e H o X %N

Digitize the beginning and
end of the line.

The length
/ appears here.
Count F.00 Segment 345 Total 6512
Digitize the first point of the single line 135.05 [1714.80 |Scale 144 |Count 141 |1
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Send the value to Estimating

When you finish digitizing single lines, click Done to send the total to Estimating.

ffpowin [_[0]

File Edit “iew Digitize Toolz Help

N RIEEL

ERZIEET LA

Click here
to send the total from ——
Digitizer ...

|Digitize the first paint of the single line 10372 13365 |Scale 174 [Count 1/

‘ Count 9.00 Segment 0.00 Taotal 100.00

‘ ... to Estimating.

i LF Length HE
Cluantity 1.000
Length ' T O
Add to Oty Beplace Oty | x Cancel | Help | [_ 0]
Group Phase Des on ;z‘;ztni?y Labor Price AI;:?J':;'R ;I
6101.00 |Framing: Plat
I} Plates 2x4 RL 118125 Inft 20000 Mhour 661
I} Plates 2x4 RL 100.00] Inft 20000 Mour a6
I} Plates 2x4 RL 7a0.00 Inft 20000 Mhour 420
6101.10 [Framing: Plates PT
I} Plates PT 2x4 EL 20,00 Inft 20000 Mour 28
I} Plates PT 2x4 RL 37500 Inft 20000 Mhour 210
6106.00 (Framing: Studs 2x4 > 2x8
I} Studs 2x4x 8 32500 each| 2000 Mour 1,392 v|
4 [ ]\ Phasettem 4 Takeoff Order A Assembly A Locationfhese A Bid|| 4] | v
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Digitizing continuous lines

calculates the length of

a continuous line. For You can find the Continuous Line command on the Digitize

Continuous Line mode @ Start the Continuous Line mode

example, you might use menu and the toolbar.
this mode to measure Dinit
. Digitize
the perimeter of a regu- Tz S, Y [ —
lar or irregular-shaped o :
lab Single Line
SHao. To start this mode, Continuous Line
Again’ you can: click here or here. I ﬁrea

- 9 9 Scales...
De‘fme the line Style To define the line style

and color. and color, click here.
= See the last and cur-

rent dimensions. | El :D: E e |

= Add or subtract the
current total to the

P — Digitize continuous lines
= Undo the entire line a To measure a straight line, you simply digitize its end points. If

point at a time. the line is curved, press down on the pointing device as you
trace. Digitizer shows the cumulative length in the totals bar as
you move along the line.

K powin [_ O]

File Edit “iew Digitize Toolz Help

Tay N [ty [ [ = | | | e

W o XS xR

2 3
Digitize the four

straight lines by
clicking points 1-5...

1 N
.. and trace the /
5

curved line.

4

Segment 0.11 Length 167.00 Total 0.00

|Diigitize the next point of the line [141.01 [136.69 [Scale 1/4 [Count 14 |1z
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Send the value to Estimating

When you finish digitizing continuous lines, click Done to send the total to Estimating.

2 powin [_ O[]

Eile Edit ‘iew

Digitize Tools Help

Click here
to send the total from
Digitizer ...

R el IS -
Segment 0.00 Length 0.00 Total 1 B?_y

|Digitize the first point of the line

(8913 [133.47 [Soale 174 [Count 171 1

... to Estimating. + LF Length
[uantity 1.000
Le Tk LU
Add to Bty Replace X Carcel ?  Hebp
e Oa _ O] x
Group Phase Description .::'?y Labor Price Al;:hnz;t =
3000.00 CONCRETE
3111.00 |Forms: Footings
i} Keyway In Footing 0 Inft 20000 hour 100
3127.00 |Forms: Edgeform Slabs _|
EdlgeFarm (Any Depth, LF) 167 .00] Inft 2500 mour 35
3160.01 (Forms: Screeds
ir] Screeds 5250 =gs 20000 mour 5
ir} Screeds 2500 =gs 20000 Mhour 150
3306.00 |(Conc: Footings -
4 [*]\Phasettem 4 Takeoff Order A Assembly A LocationPhase A4 Bid|| 4] | v
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Digitizing areas

the area of a closed
shape. For example,
you might use this mode toolbar.

to measure the surface

area and perimeter ofa PN B Digitize
regular or irregular- Count

shaped slab. K Single Line
; To start this mode, Confinuous Line
As in the other modes, click here or here.

you can: To define the line

style and color, Scales..
» Define the line style click here. \’
and color.

= See the last and cur- | EIREREE
rent dimensions.

You can find the Area command on the Digitize menu and the

Area mode calculates @ Start the Area mode

= Add or subtract the Digitize areas

current total to the
grand total. Digitizing an area involves tracing or digitizing the outline of a

= Undo the last point shape much like the Continuous Line mode. But in Area mode,
p Digitizer automatically closes the shape by connecting the last

digitized. o . . . . .
w & point digitized to the first point while continuously calculating
"y When you digitize the enclosed area. When the shape is complete, click the Add or
areas, Digitizer also cal- Done button.
culates the perimeter.
You can transfer the F4lPovin M= 5
value of that perimeter Fle Edi iew Digize Tools Help
to an estimate using the ERINE R BT IR
Recall Perimeter com- _ _ '
mand. in Estimating. First point Last point
17 6
5 4
|___| Connectingline drawn
by Digitizer
2 3
Perimeter 30.97 Area 16.85 Total 0.00
|Digitize the nest point of the area [12861 [104.83 [Scale 1/4 [Count 141 [1 4
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N

@e

File Edit iew Digtize Tools Help

If you want to exclude part of an area from the total, simply digitize the second area and
use the Subtract button.

Ffl powiin [_ O]

oy N, [l | =B | ]

S X | SN

... and click here to

subtract it from the total.

Digitize a
second area ...
\—’j
Perimeter | 0.00 Area | 0.00

Total 18.71

|Digitize the first point of the area

[155.40 [104.90 [Scale 1/4 [Caurt 141 | 2

Send the value to Estimating

When you finish digitizing areas, click Done to send the total to Estimating.

When you click Done, the
total goes into the estimate.

McKenzie Oa

ks 2

Phase

Description

Labor Price

3380.01 |Finish: General
Trowwel Finish 16.71] soft 23.00 maour 12
1T} BroomiFloat Finish 5,250.00 =oft 2000 fhour 2,100
1] BroomiFlost Finish 250000 sogit 20,00 fhour 1,000
3951.00 |Misc: Set Grade Pins
1] Set Grade Pins st Footing 250.00 Intt 20,00 fhour a0
G000.00 WOOD & PLASTICS -|
1 PI‘\PhaseﬂtemA Takeoff Crder J& Azzembly J& LocationPhaze ﬂ| 4| | Fl s
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Printing the image

After you have digitized Digitize the image
an image, you can print
it. You also have the Digitize the image and turn off the digitizing mode. To turn off
option of including a the digitizing mode and remain in Digitizer, select the cancel
project name and refer- button:
ence information in the X Cancel
title block.
The project name and Page Setup
reference are stored for
the current digitizing B To display the Page setup window, select the Page setup
session only. When you command on the File menu. Enter the project name and
exit Digitizer and Esti- reference information you want to print in the title block on the
mating, the project printed image.
name and reference
information are
cleared. Save As [ Export...
:@3 The printed image is
‘scaled’ to make best Bt
use of the paper size of =l Page Setup
your printer (either por- Praject name: [McKenzie Daks 2
trait or landscape). The :
sarile am e printed Reference: |Landscapind
image will not match [V 0K | X Concel | 2 tep |
your plan scale, but is X
correct for the printout. Enter the project

name and reference

information here. Then click OK.
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Print

You can find the Print command on the File menu and the toolbar. If you have set up a
project name and reference information, the title block that prints with the image looks
similar to the one shown below.

GXLN Ee
save As S Export.
To print, Fage setup...
Exit

Sample Title Block

Timberline Digitizer
Project name: McKenzie Oaks 2
Reference: Landscaping
Date: Thursday, April 26, 2001 3:57 PM
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Time-saving tips

This section includes tips to help you work more efficiently. In addition, you’ll find these
and many other hints throughout the Help system.

If you want to learn more about working with Windows, choose Help on the Start menu.
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Making the most of Digitizer

Digitizer provides many
convenient features to
help you work effi-
ciently. In addition to
the standard Windows
techniques, there are
others which may not be
obvious at first glance.

32 Getting Started

Shortcut menus

Shortcut menus are special menus that open when you click in a
window with the right mouse button (or the designated button on
the pointing device). Shortcut menus provide quick access to
commands related to your current task.

= In Digitizer, most of the toolbar and menu commands are
available on the shortcut menu.

= In Estimating, the Digitizer and Recall Perimeter commands
are available on the shortcut menu.

Status bar

The status bar is located at the bottom of the Digitizer window;
helpful messages and instructions appear here. You can also see
the current drawing and count scales. A quick way to open the
Scales window is to click on the Scale or Count scale field.

Totals bar

The totals bar is located directly above the status bar. This is
where Digitizer displays the current total(s) and grand total for
the session. Click the totals bar to open the Current Totals
window.

Current Totals m
Last Dimensions

- Count: 0.00
This area shqws thg Segment 0.00
appropriate dimensions ———p Loz 000
from the previous session. Ao 534
Perimeter: 616

This area shows the Current Dirmensions
appropriate dimensions > Segment: 0.00
for the current session. Count: 0.00




Placing the toolbar conveniently

Initially, the toolbar is positioned below the graphics area. To make digitizing more
efficient, you can move the toolbar around or even change its size and shape.

oy "\ Y [ | o o= [ B @D 0] T

= oS SN

Done Scale Undo Print
Clear Clear Total
Close
Count Add Zoom Window Help
Single Line Subtract Zoom Extents
Continuous Line
Area Define Line/Count Symbol

With the pointer on the background of the toolbar, simply drag it anywhere in the digitizer
window.

= [f you drop the toolbar in the graphics area, you can change its shape and size by
dragging one of its borders.

= [If you drop the toolbar on the window frame, it becomes attached to the frame.

Saving an image

Digitizer provides a way for you to document the dimensions you digitize. The Save
As/Export command on the File menu saves the image in the Digitizer window as a file
which can be imported by other applications. There are options for saving the image in a
.bmp (bitmap), .emf (enhanced metafile), .jpg (JPEG), or .tif (TIFF) format. You can also
edit a saved image in programs such as Paint.
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What to do if you make a mistake
Digitizer provides several ways for you to redo one or more digitized entities.

Undo =

Use Undo to reverse your previous action. This button deletes the last entity that was
digitized. Each click deletes one more digitized point until the current total reaches
zero. In Single Line mode, Undo deletes only the last line digitized.

Clear =#

Use Clear when you want to redo a digitized object. This button clears the graphics and
totals, but leaves you in the selected digitizing mode. Clear is also available on the
shortcut menu.

Cancel X

Use Cancel to start over or turn off a digitizing mode. This button deletes the image and
both totals. After that, you can choose a different digitizing mode or close the digitizing
session.

Clear Graphic

Use the Clear Graphic command when you want to delete the image from the graphics
area without clearing the values in the totals bar.

To use this command, select Clear Graphic from the shortcut menu. Clear Graphic is
also available on the Edit menu.

Clear Total *x

Use Clear Total when you want to reset the total to zero without losing the digitized
image. This allows you to work with several images at the same time. Clear Total is also
available on the Edit menu.
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Digitizing from Estim

ating

Digitizer works hand in hand with Timberline Estimating products to make your job
easier. You can start Digitizer from any takeoff quantity cell or variable field in

Estimating.

Look for this button on the
Estimating toolbar.

Setting the digitizing mode

—’J'I?_r

g@g Or right-click a takeoff quantity or variable and
choose the command from the shortcut menu.

in advance

A most convenient feature is the ability to assign a digitizing mode to the variables used
by formulas in Estimating. Then whenever you start Digitizer from such a variable, it
automatically starts up in the appropriate mode.

In the Formula window,  Formula 7] x]
h|ghl|ght a variable and « | . |
click here. o E
Urit of measure m Add |
Insert Wariable Insert Function Inzert Formula
Delete |
hoth Bar: S Cv BackFil
_I L Block Fill In: Bename |
Length - Joist R * Cv Conc Beam
Length - Fiafterd . _I CY Conc Cal. HLI
Test...
| Lenqth *
Variable ﬂﬂ
<« >
Wariable ILength ! = ]
Add _I
Unit of measure Ifeet VI Maﬁimuml
— o || Lo [ i |
Drefault value Minirmum
Bename |
Digitizer Mode
Help nat
 Mone In the Variable window, click
" Count here and click a digitizer mode.
= Sirle line

i Hea

¢ Ok Ix Cancel |?

Help |
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Go ahead ... try it out

Now that you’ve installed the software and been through this booklet, go ahead—and try
digitizing some dimensions. It’s so easy that you can just start right in. It won’t be long
before you’ll feel like an old pro.

For assistance beyond this booklet, our comprehensive Help system is always close at
hand.

= While working with Digitizer, you can quickly get context-sensitive help with the [?]
button or F1 key.

= If you want additional guidance, check out the information in the Help system.

And in conclusion

We think you’ll find Digitizer a useful tool. Thanks for taking the time to read this booklet
and for becoming one of our valued users.
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